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Legal Disclaimer
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All forward-looking statements are subject to various risks and uncertainties that could cause actual results to differ materially from expectations. Readers are cautioned not to place undue reliance on these forward-looking statements, which speak only as of their dates, and they should not be relied upon in making purchasing decisions.
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[bookmark: _Toc516648434][bookmark: _Toc11147450][bookmark: _Toc96077880]Release Notes
This document contains shared release notes and planned changes. Shared release notes and planned changes document features and changes that apply to SAP Concur solutions site-wide or to multiple SAP Concur products and services. They include but are not limited to:
· Security-related features and changes such as annual security certificate renewals and changes in support for security ciphers and protocols
· Site-wide UI features and changes such as changes to the home page, changes to the site header or footer, or the implementation of new site-wide UI themes
· Sign-in process features and changes such as the addition or removal of sign-in features, URL changes, and domain name changes
· Production and test environment features and changes
· Global settings or administration page features and changes such as the addition of new site-wide settings or changes to the design of the administration pages
· Changes to processes such as where and when release notes are published
For New Features and Changes that apply to a single product and/or service see the release notes for that product or service. Links to the product and service-specific release notes can be found on the following pages:
Professional Edition
Standard Edition
Small Business Edition
[bookmark: _Toc96077881]File Transfer Updates
[bookmark: _Toc96077882]**Ongoing** Rotating PGP Key for File Transfers

	[bookmark: _Hlk92987153]Information First Published
	Information Last Modified
	Feature Target Release Date

	February 2021
	January 21, 2022
	January 15, 2021 and October 11, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96077883]Travel, Expense, Invoice, Request, Intelligence | Professional & Standard
Overview
Files transferred to SAP Concur products must be encrypted with the SAP Concur public PGP key, concursolutionsrotate.asc. 
concursolutionsrotate.asc 
· Key file is available in client’s root folder
· Key ID 40AC5D35
· RSA 4096-bit signing and encryption subkey
· Key expires every 2 years
· Client is responsible for replacing the key before it expires
Next expiry date: September 4, 2022
SAP Concur plans to replace the current rotating public PGP key in the client’s root folder 90 days before the expiration date
The SAP Concur legacy PGP key (key ID D4D727C0) will be decommissioned on October 11, 2022. You must switch to using the rotating PGP key before that date. Files encrypted with the legacy PGP key will not be processed after October 10, 2022.
This announcement pertains to the following file transfer DNS endpoints:
· st.concursolutions.com
· mft-us.concursolutions.com
· vs.concursolutions.com
· st-eu.concursolutions.com
· mft-eu.concursolutions.com
Business Purpose / Client Benefit
The rotating public PGP key provides greater security for file transfers.
What the Administrator Sees
An administrator with the required file transfer credentials can log into the file transfer site to retrieve the rotating public PGP key, concursolutionsrotate.asc, from the root directory.
Configuration / Feature Activation
Your internal file transfer administrator can add the key to their PGP keyring and start using it to encrypt any files being transferred to SAP Concur. 
If assistance is required, please contact SAP Concur support.
For more information, refer to the Shared: File Transfer for Customers and Vendors User Guide.
[bookmark: _Toc96077884]Invoice Capture and Expense Receipt Handling
[bookmark: _Toc96077885]CFDi Version 4.0 Now Supported (Mexico)

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 11, 2022
	--
	February 11, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96077886]Expense, Invoice | Professional & Standard
Overview
With the January 22, 2022 release, Concur Invoice and Concur Expense support the new Comprobante Fiscal Digital por Internet (CFDi) version 4.0 format provided by Mexican tax authorities. This format will be the mandatory format beginning May 1, 2022. Regulations in Mexico require that a CFDi document in XML format be attached to every submitted invoice and reimbursable expense.
Clients have the option to send tax documentation using either CFDi version 3.3 or 4.0 until April 30, 2022 when version 3.3 will be deprecated.
With the availability of the new CFDi format, users reporting to Mexican tax authorities and submitting invoices and reimbursable expenses with CFDi attachments will be in compliance with current Mexican tax regulations.
Business Purpose / Client Benefit
[bookmark: _Hlk95397422]This update supports users reporting to Mexican tax authorities who need their invoice or receipt and attached CFDi tax document submitted as a single invoice in Concur Invoice or reimbursable expense in Concur Expense.
Configuration / Feature Activation
Administrators can enable users to upload CFDi attachments in Group Configurations.
This update is automatically available; there are no additional configuration or activation steps.
For general information about this functionality, refer to the Concur Invoice: Capture Processing (Client-Managed) Setup Guide, the Concur Invoice: Capture Processing (Client-Managed) User Guide, the Concur Expense: Receipt Handling – Digital Tax Invoice Setup Guide, and the Concur Expense: Receipt Handling – Digital Receipts Setup Guide.
[bookmark: _Toc96077887]Miscellaneous 
[bookmark: _Toc96077888]**Ongoing ** SAP Concur Homepage Changes

	Information First Published
	Information Last Modified
	Feature Target Release Date

	October 8, 2021
	January 14, 2022
	Q4 2021 – Q2 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96077889]Travel, Expense, Invoice, Request | Professional & Standard
Overview
In Q4, 2021, SAP Concur began redirecting clients to a new homepage. The appearance of the new homepage is identical to the previous SAP Concur homepage. The new homepage has enhanced functionality when services become temporarily unavailable.
The roll out of the new homepage is phased:
Phase 1: At the beginning of Q4, SAP Concur began redirecting Concur Expense, Concur Invoice, and Concur Request clients in the US Datacenter to the new homepage. 
Phase 2: In December 2021, SAP Concur will begin redirecting Concur Expense, Concur Invoice, and Concur Request clients in the EU Datacenter to the new homepage.
Phase 3: In Q2 of 2022, SAP Concur will begin redirecting the remaining clients in the US and EU datacenters to the new homepage. The remaining clients include those with Concur Travel standalone or Concur Travel with Expense, Invoice, and/or Request.
Business Purpose / Client Benefit
This change ensures that the SAP Concur homepage is available even when some services are unavailable and improves the consistency of the sign in experience.
What the User Sees
With the old homepage, when a user signs into their SAP Concur products, they see their homepage.
The appearance of the homepage varies depending on which products and services are enabled for the client and the permissions assigned to the user.

If some products or services are unavailable while other products and services are up and running, a modified version of the user’s homepage similar to the following appears: 
[image: ]
After a client is migrated to the new homepage, if one or more services are unavailable, when a user signs in to their SAP Concur products, they will see the usual homepage, but if the user navigates to a page for a service that is unavailable, they will see a page similar to the following:
[image: ]
After migration to the new homepage, if all services are available, this change is transparent to the user and they see a homepage that is identical to the pre-migration homepage.
Example Homepage

Configuration / Feature Activation
This change occurs automatically; there are no configuration or activation steps.
[bookmark: _Toc96077890]**Ongoing** SAP Concur Migration to Cloud Platform in AWS

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 18, 2022
	--
	Ongoing in 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96077891]All Products | All Editions
Overview
SAP Concur plans to migrate from a pure private cloud operation, where all equipment is owned by SAP Concur, to a cloud platform. We plan to close our own private data centers in favor of a cloud platform implemented in Amazon Web Services (AWS). While this process started in 2017, we are focused on the final phase of the migration in 2022 for the North American and EMEA data centers.
Business Purpose / Client Benefit
This change provides a stronger security posture, improved performance and stability, and faster innovation for our clients.
Configuration / Feature Activation
This change will occur automatically.
For details, refer to the SAP Concur Cloud Platform Strategy FAQ.
[bookmark: _Toc96077892]Product Settings
[bookmark: _Toc96075271][bookmark: _Toc96077893]Product Settings Page Enhancements

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 13, 2021
	January 14, 2022
	January 27, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96075272][bookmark: _Toc96077894]Expense, Invoice, Request | Standard
Overview
The Product Settings page in Concur Standard Edition has been enhanced. 
Business Purpose / Client Benefit
These changes improve the functionality of the Product Settings page.
What the Admin Sees
A user with the required administration permissions sees the following enhancements:
· If any required information is missing from the Accounting, Expense Types for Expenses, Employee Reimbursements, Expense Approvals, Payment Types, User Accounts, or VAT settings pages, an alert banner appears at the top of the Product Settings page.
Alerts Example
[image: ]
The admin can click the down arrow in the banner to view more details about the alert(s).
[image: ]
Clicking the "Visit" link at the end of an alert, opens the configuration page for the setting that requires attention.
· If any required information is missing from the Accounting, Expense Types for Expenses, Employee Reimbursements, Expense Approvals, Payment Types, User Accounts, or VAT settings pages, an alert appears on the tile for the affected setting and the Edit button becomes a Fix button.
For example, if Expense Types have not yet been mapped to Account Codes on the Expense Types for Expenses page, an alert appears on the Expense Types for Expenses tile and the button on the tile is labeled Fix.
[image: ]
· If required information is missing from a settings page, an alert appears at the top of the affected settings page.
For example, if VAT configurations have not yet been completed, an alert appears at the top of the Taxation – VAT Tracking page.
[image: ]
If User Assistance for Admins is enabled for the entity and a guided tour for the feature exists, the admin can click Show me how to do this to launch a tutorial with information about how to complete the configuration.
Configuration / Feature Activation
These enhancements are automatically available.
[bookmark: _Toc96077895]Profile Settings
[bookmark: _Hlk93045377][bookmark: _Toc96077896]Removal of the Connected Apps Page

	Information First Published
	Information Last Modified
	Feature Target Release Date

	January 14, 2022
	February 11, 2022
	February 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96077897]Travel, Expense, Invoice, Request | Professional & Standard
Overview
SAP Concur plans to remove the Connected Apps page in Profile Settings.
Business Purpose / Client Benefit
Periodically, under-utilized features or pages are removed to improve usability. This is a rarely used page; it no longer meets its purpose of driving partner application usage.
What the User Sees
When a user navigates to Profile > Profile Settings, they no longer see the Connected Apps link under Other Settings.
Before
[image: ]
After
[image: ]
The user no longer has access to the Connected Apps page.
[image: ]
Users can continue to connect to available apps through the App Center. A link to the App Center is available in the SAP Concur page header.

[image: ]
Configuration / Feature Activation
This change occurs automatically; there are no configuration or activation steps.
[bookmark: _Toc96077898]SAP Fiori Themes
[bookmark: _Toc96077899]Profile Menu Functional Changes Under Fiori Light Theme 

	Information First Published
	Information Last Modified
	Feature Target Release Date

	December 10, 2021
	January 14, 2022
	January 14, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96077900]Travel, Expense, Invoice, Request | Professional
Overview
With the January release, the Profile menu within the SAP Fiori theme has been updated. This update includes changes to the layout of the menu items and some changes in functionality.
Business Purpose / Client Benefit
The Profile menu within the SAP Fiori theme is now functionally more efficient and easier to use. 
The SAP Fiori theme harmonizes the look and feel of the SAP Concur offerings with those of other SAP products, providing a more consistent user experience.
What User Sees
With the new theme enabled, most users (users without rights to work on behalf of another) see options to access their personal profile settings and to log out of the product. The layout and appearance are changed, but the functionality remains the same.

	Current Theme
	SAP Fiori Light Theme

	[image: ]
	[image: ]


What the User with "Act as Another" Rights Sees
In addition to the Profile Settings and Sign Out option, users granted rights to work on behalf of another see the Act as Another User option.

	Current Theme
	SAP Fiori Light Theme

	[image: ]

	[image: ]
Clicking the arrow reveals the option to act on behalf of another user:
[image: ]


Functional changes to the Profile menu under the new theme include the following:
· Myself: This option serves two functions, it provides visual identification and confirmation that the user is working on their own behalf and enables the user to return to working on their own behalf after acting as another user. 
· Switch: This button toggles the user between working for a user and working on their own behalf. 
Switching Between Acting for Another User and Acting for Yourself
There are minor functionality differences including the following functional changes:
· Text: The wording on the Fiori interface is updated to better explain the action being taken.
· User Selection and Switch button: The actions of selecting a user and switching to act on their behalf are ordered on a single line and the Cancel button has been removed. 

	Current Theme
	SAP Fiori Light Theme

	[image: ]
	[image: ]


With the Fiori theme active, a user enters the name of the user they want to act for and, after selecting the user's name, clicks the Switch button to begin acting as the specified user. When acting as another user, the name of the user currently being acted for appears above the Profile menu.

	Current Theme
	SAP Fiori Light Theme

	[image: ]
	[image: ]


The user resumes acting on their own behalf by selecting the Myself option and clicking Switch.
Configuration / Feature Activation
There are no configuration or activation steps; the Profile menu in the SAP Concur Fiori Light Theme is automatically updated with the January 2022 release.
Clients who opt-in to preview the SAP Fiori theme and who want to provide feedback, can register on the following page to participate in the SAP Continuous Influence program: SAP Customer Influence

After registering or logging in, clients can request to participate in the Hands-on system Approach of Consistent User Experience based on SAP IE Scenario Travel-to-Reimburse opportunity.

Registration for this SAP Customer Influence opportunity is limited and may close.
For more information about acting as another user refer to Shared: Delegate Configuration Setup Guide and the Expense or the Invoice version of the Proxy Logon User Guide. For more information about the SAP Fiori theme see New Permission to Enable Preview of Fiori Light Theme in the December 2021 release notes.
[bookmark: _Toc96077901]SAP Concur User Assistance
[bookmark: _Toc96077902]Notice Regarding Stale Documentation

	Information First Published
	Information Last Modified
	Feature Target Release Date

	January 14, 2022
	February 11, 2022
	Q1 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96077903]All Products | All Editions
Overview
SAP Concur User Assistance will archive and eventually delete documents as needed to maintain accurate, relevant, and concise information for all supported audiences including end users, client administrators, SAP Concur support, and implementation colleagues. 
Archiving activities performed by SAP Concur User Assistance will comply with data retention best practices and adhere to legal compliance requirements.
The initial exercising of this notice will apply to the archiving of stale (example) online help documents currently available on the concurtraining.com server. All current online help documents are now located on the SAP Help Portal.
For more information, refer to the Help Menu Directed to SAP Help Portal release note in the November 2021 product release notes. 
IMPORTANT: SAP Concur User Assistance considers this notice sufficient to cover the future archiving of documents not specifically mentioned here at such time as we deem them stale. Further notices are not planned. 
Business Purpose / Client Benefit
This notice serves to expedite the appropriate archiving of stale documentation.
Configuration / Feature Activation
Archiving will occur automatically; there are no configuration steps or actions required. Bookmarks to the archived content will no longer work. Refer to the SAP Help Portal for the current links to deliverables:
Concur Expense: 
https://help.sap.com/viewer/product/CONCUR_EXPENSE/LATEST/en-US
Concur Invoice: 
https://help.sap.com/viewer/product/CONCUR_INVOICE/LATEST/en-US
Concur Request: 
https://help.sap.com/viewer/product/CONCUR_REQUEST/LATEST/en-US
Concur Travel: 
https://help.sap.com/viewer/product/CONCUR_TRAVEL/LATEST/en-US
[bookmark: _Toc96077904]Security
[bookmark: _Toc96077905]Some TLSv1.2 Ciphers No Longer Supported (Feb 1, 2022)

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 13, 2021
	January 14, 2022
	February 1, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96077906]Travel, Expense, Invoice, Request | All Editions
Overview
Beginning on February 1, 2022, SAP Concur solutions will no longer support connections to *.concursolutions.com and * api.concursolutions.com that use the following TLSv1.2 ciphers:
	Akamai/OpenSSL cipher name
	IANA cipher name

	AES256-GCM-SHA384
	TLS_RSA_WITH_AES_256_GCM_SHA384

	AES128-GCM-SHA256
	TLS_RSA_WITH_AES_128_GCM_SHA256

	ECDHE-RSA-AES256-SHA384
	TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384

	ECDHE-RSA-AES128-SHA256
	TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256

	ECDHE-RSA-AES256-SHA
	TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA

	ECDHE-RSA-AES128-SHA
	TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA


To ensure that connections to *.concursolutions.com and * api.concursolutions.com are not disrupted, clients and partners who connect to *.concursolutions.com and *api.concursolutions.com through an application that uses a retired cipher must update the application to a supported cipher before February 1, 2022.
Business Purpose / Client Benefit
This update provides ongoing security for our products and services.
Confirming Supported Ciphers
The following ciphers included in the ak-akamai-2020q1 cipher profile are supported:

	Akamai/OpenSSL cipher name
	IANA cipher name

	TLS-AES-256-GCM-SHA384
	TLS_AES_256_GCM_SHA384

	TLS-CHACHA20-POLY1305-SHA256
	TLS_CHACHA20_POLY1305_SHA256

	TLS-AES-128-GCM-SHA256
	TLS_AES_128_GCM_SHA256

	ECDHE-RSA-AES256-GCM-SHA384
	TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384

	ECDHE-RSA-AES128-GCM-SHA256
	TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256

	ECDHE-RSA-CHACHA20-POLY1305
	TLS_ECDHE_RSA_WITH_CHACHA20_POLY1305_SHA256


If your cipher suite includes both supported and unsupported ciphers, connections to *concursolutions.com through a web browser will not be disrupted. During the process of establishing the connection, the *concursolutions.com server will choose the most secure cipher in your cipher suite.
You can confirm that your cipher suite includes a supported cipher by cross-referencing the Akamai/OpenSSL cipher name with the IANA cipher name in the ak-akamai-2021 (default) column in the following table. 
Supported ciphers are indicated with a check mark.
[image: ] 
Testing Ciphers
The following procedure is intended for use by system administrators who want to test whether their cipher suite configuration will work correctly when connecting to SAP Concur solutions after support for the ciphers listed above has been removed. 
This procedure configures the system admin's local machine to connect to an akamai staging environment where support for the listed ciphers has already been removed. 
Summary of the procedure:
· Retrieve the IP address of the akamai production environment.
· Retrieve the IP address of the akamai staging environment.
· Redirect navigation to concursolutions.com to the akamai staging environment by editing the local Hosts file.
· Test a connection to concursolutions.com.
Confirm Your Cipher Suite is Working Correctly
Retrieve the IP Address of the Akamai Production Environment
Ping www.concursolutions.com
Windows: Open a Command Prompt window, type “Ping www.concursolutions.com” and then press Enter.
Mac: Open Terminal, type “Ping www.concursolutions.com” and then press Enter.
Example response
Pinging e7868.b.akamaiedge.net (23.46.104.197): 56 data bytes
64 bytes from 23.46.104.197: icmp_seq=0 ttl=50 time=125.070 ms
64 bytes from 23.46.104.197: icmp_seq=1 ttl=50 time=111.866 ms
64 bytes from 23.46.104.197: icmp_seq=2 ttl=50 time=111.967 ms
64 bytes from 23.46.104.197: icmp_seq=3 ttl=50 time=112.435 ms
Copy the highlighted address in the response.
Example address
e7868.b.akamaiedge.net
Retrieve the IP address of the akamai staging environment
1. In the Command Prompt or Terminal window, ping the copied address, but with “-staging” appended to “akamaiedge”.
Example Ping command
Ping e7868.b.akamaiedge-staging.net
Example response
Pinging e7868.b.akamaiedge-staging.net (104.76.225.252): 56 data bytes
64 bytes from 104.76.225.252: icmp_seq=0 ttl=50 time=118.809 ms
64 bytes from 104.76.225.252: icmp_seq=1 ttl=50 time=242.459 ms
64 bytes from 104.76.225.252: icmp_seq=2 ttl=50 time=112.145 ms
64 bytes from 104.76.225.252: icmp_seq=3 ttl=50 time=114.994 ms
Copy the highlighted IP address in the response.
Example IP address
104.76.225.252
Update the Local Hosts File
MAC:
1) Open Terminal
2) Type “sudo nano /private/etc/hosts” and then press Enter.
[image: ]
If prompted, enter your administrator password.
3) After the comments at the beginning of the file, add the IP address you copied in step 4, followed by “www.concursolutions.com”.
Comments are preceded with a hashtag (#). Your entry should not include the hashtag.
Example entry
104.76.225.252 www.concursolutions.com
4) Save the file (Ctrl-o) and close Terminal (Ctrl-x).
Windows:
Launch Notepad as administrator by typing “Notepad” into the Windows search bar, right-clicking Notepad in the search results, and then clicking Run as administrator.
[image: ]
If prompted, click Yes in the User Account Control window.
5) In Notepad, click File and then click Open.
6) Navigate to C:\\Windows\System32\drivers\etc and then, to the right of the File name field, choose All Files (*.*) from the menu.
[image: ]
7) Open the hosts file.
8) After the comments at the beginning of the file, add the IP address you copied in step 4, followed by “www.concursolutions.com”.
Comments are preceded with a hashtag (#). Your entry should not include the hashtag.
Example entry
104.76.225.252 www.concursolutions.com
[image: ]
9) In the File menu, click Save.
Connect to *concursolutions.com from the Local Machine
After configuring your local hosts file to direct connections to *concursolutions.com to the akamai staging environment, connect to *concursolutions.com from the local machine through the method you need to test. 
Your system administrator might need to test connections to *concursolutions.com made via an API call, connected application, or by navigating to the sign-in page through a web browser and signing in as an SAP Concur user.
Configuration / Feature Activation
To ensure that connections to *.concursolutions.com and * api.concursolutions.com are not disrupted, any applications that use an unsupported cipher must be updated to use a supported cipher before February 1, 2022.
If your cipher suite includes both supported and unsupported ciphers, connections to *concursolutions.com through a web browser will not be disrupted. During the process of establishing the connection, the *concursolutions.com server will choose the most secure cipher in your cipher suite.
[bookmark: _Toc96077907]Supported Configurations
[bookmark: _Toc96077908]Change in Support for Internet Explorer 11

	Information First Published
	Information Last Modified
	Feature Target Release Date

	June 11, 2021
	February 18, 2022
	January 14, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


[bookmark: _Toc95482201]Applies to:
[bookmark: _Toc96077909]Travel, Expense, Invoice, Request, Analysis/Intelligence | All Editions
Overview
[bookmark: _Hlk19876476][bookmark: _Hlk19876428]On January 1, 2022, SAP Concur began transitioning away from support for Internet Explorer 11 (IE 11). This change is in line with other SAP solutions, industry best practices, and Microsoft’s lifecycle policy for IE 11.
Until Cognos 11 has been rolled out for all Analysis and Intelligence clients, we will provide support and allow exceptions for investigation to issues related to Cognos 10 and IE 11. For more information, refer to the Cognos 11 User Interface Update FAQ.
After January 1, 2022, SAP Concur development teams will not design new features, user interface enhancements, or security or bug fixes with IE 11 in mind. Over time, new functionality and existing functionality might not work properly on IE 11.
SAP Concur users are not blocked from access when using IE 11. They can still sign in to their SAP Concur solutions. However, to ensure their users can continue to work successfully and securely with SAP Concur solutions, SAP recommends that clients move away from allowing the use of SAP Concur solutions on IE 11 and move to a more modern, supported browser. 
Business Purpose / Client Benefit
This change enables SAP to speed up adoption of the latest browser innovations and provide a stronger security posture.    
What the User Sees
Users who navigate to concursolutions.com using Internet Explorer 11 will see a banner with the following message:
"You are using Internet Explorer. Beginning January 1, 2022, SAP Concur began transitioning away from support for Internet Explorer 11. For details, refer to the SAP concur Internet Explorer 11 Support Policy Change FAQ. View FAQ"
The message can be temporarily dismissed by clicking the X in the upper right corner of the banner. 
[image: ]
Users who have chosen not to accept concursolutions.com functional cookies will not see the X and will not be able to dismiss the message. To dismiss the message, these users can temporarily enable functional cookies, refresh the web page, dismiss the message, and then disable functional cookies.

For information about how to enable and disable functional cookies, refer to the Cookie Preferences and User Consent fact sheet.
Configuration / Feature Activation
There are no configuration steps; these changes occur automatically.
For more information, refer to the Internet Explorer 11 Support Policy Change FAQ.
[bookmark: _Toc96077910]Test Entities | Production Sandbox Environment
[bookmark: _Toc96077911]**Ongoing** Most Recently Used Lists Not Migrated

	Information First Published
	Information Last Modified
	Feature Target Release Date

	September 2021 
	January 21, 2022
	October 1, 2021 through mid-2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96077912]Expense, Invoice, Request | Professional
Overview
Some SAP Concur users use Production Sandbox Environment (PSE) entities to set up, test, and train on new configurations prior to deploying them to their live production entity. SAP Concur plans to migrate PSEs as part of our move to Amazon Web Services (AWS).
For more information, refer to the SAP Concur Cloud Platform Strategy FAQ.
Due to the architectural changes that SAP Concur must make to support this move, when PSEs are migrated to the new environment, some Most Recently Used (MRU) list items within the PSE will not be migrated.
MRU lists consist of recent selections made by the user. These lists are generated overtime as users interact with various menus and other defined lists and they will be regenerated after the PSE is migrated to the new environment.
These changes apply to PSEs once they are moved or created in the AWS environment, which will occur at a future date.
Business Purpose / Client Benefit
Once in AWS, PSEs benefit from the same stability, monitoring capabilities, and level of performance as production entities.
What the User Sees
After the migration, some MRU lists that were generated prior to the migration will be empty. These lists will be regenerated automatically through the normal use of the PSE.
The following screenshots show some examples of MRU lists that will be impacted by the migration:
Create New Expense in Concur Expense
[image: ]
New Segment in Concur Request
[image: ]
Configuration / Feature Activation
This change occurs when a PSE is migrated to the new AWS environment; there are no configuration or activation steps. The MRU lists will be regenerated with normal user of the entity.
[bookmark: _Toc96077913]**Ongoing** Production Sandbox Environment Login Updates

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 2021 
	January 21, 2022
	October 1, 2021 through mid-2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96077914]Expense, Invoice, Request | Professional
Overview
Some SAP Concur users use Production Sandbox Environment (PSE) entities to set up, test, and train on new configurations prior to deploying them to their live production entity. SAP Concur plans to migrate PSEs as part of our move to Amazon Web Services (AWS).
For more information, refer to the SAP Concur Cloud Platform Strategy FAQ.
Today, a user can maintain the same login ID for their test and production entities because they are in separate environments. With the plan to migrate both test and production entities to the same AWS production environment in the future, this will no longer be possible since each login ID must be unique. 
While there is no action required for clients regarding this update, we want to ensure clients are aware of it because the change will be visible in certain areas of PSEs. To account for this change, SAP Concur will append all PSE login IDs with a ".uat” domain during both migration and user creation to ensure they are unique and do not conflict with any existing production login ID. For example, johnsmith@123.com will become johnsmith@123.com.uat.
IMPORTANT: No changes will made to the login IDs in the current implementation environment in our private data centers.

This process will occur in the background during both the migration and user creation processes. Because SAP Concur will manage this process, users will NOT have to make any changes to their login ID. 

Migrated users will still use the same implementation URL and login ID they used prior to the AWS migration. 

New clients will use the production URL with the appended login ID, which will include the appended domain (for example, johnsmith@123.com.uat). 
This change will help to safeguard against any conflicts with production login IDs. 
User Creation: Additionally, clients can use the exact same employee import files as they would in production. The uat domain will also be applied to all aspects of user creation: FTP import, Excel import, entity restore, and more.
Extracts: When generating accounting extracts or financial integration documents, SAP Concur will automatically remove the uat domain from login IDs that were appended during user creation. This will help to generate realistic extracts without requiring any actions from the clients, such as removing the appended domain.
These changes apply to PSEs once they are moved or created in the AWS environment, which will occur at a future date.
Business Purpose / Client Benefit
Once in AWS, PSEs will benefit from the same stability, monitoring capabilities, and level of performance as production entities.
Configuration / Feature Activation
These changes occur automatically; there are no additional configuration or activation steps.
[bookmark: _Toc96077915]**Ongoing** Unique Address Required for PSE Email Verification

	Information First Published
	Information Last Modified
	Feature Target Release Date

	August 2021 
	January 21, 2021
	October 1, 2021 through mid-2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96077916]Expense, Invoice, Request | Professional
Overview
Some SAP Concur users use Production Sandbox Environment (PSE) entities to set up, test, and train on new configurations prior to deploying them to their live production entity. SAP Concur plans to migrate PSEs as part of our move to Amazon Web Services (AWS).
For more information, refer to the SAP Concur Cloud Platform Strategy FAQ.
When PSEs are migrated to the AWS production environment, verified emails from the existing PSE will not carry over to the new PSE. As a result, when users test verified email functionality in a future PSE, it is recommended that the employee uses an email that is different from the email configured in their production entity. This process is required as the email in the existing PSE was most likely already verified in production and, therefore, cannot be verified in another entity.
With respect to user email addresses, the Receipt Recognition service validates user email addresses and as such, only one instance of an email address can be associated with a user account. To test in production, clients will be required to utilize alternate email addresses that are not currently associated with any production user account. If a client attempts to set up a test account in production using an email address already associated with a corresponding user profile, it will fail the validation process.
These changes apply to PSEs once they are moved or created in the AWS environment, which will occur at a future date.
Business Purpose / Client Benefit
Once in AWS, PSEs will benefit from the same stability, monitoring capabilities, and level of performance as production entities.
What the Admin Sees
BEFORE – Existing Email in Existing PSE
[image: Before screenshot of Existing Email in Existing Test Entity]
AFTER – New Email in New/Future PSE
[image: After screenshot of New Email in New/Future Test Entity]
Configuration / Feature Activation
These changes occur automatically; there are no additional configuration or activation steps.
[bookmark: _Toc96077917]User Assistance for End Users
[bookmark: _Toc96077918]Countries Added to User Assistance List

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 11, 2022
	--
	February 11, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96077919]All Products | Professional & Standard
Overview
On February 11, 2022, SAP Concur added four new countries/regions to the list of countries/regions on the User Assistance page. The following countries/regions were added to the list:
· Denmark
· Djibouti
· Dominica
· Dominican Republic
Business Purpose / Client Benefit
This change enables clients to enable and disable user assistance for these additional countries/regions.
What the Admin Sees
On entities where User Assistance for End Users is enabled, client admins will see the additional countries/regions on the list on the User Assistance page. 
The User Assistance page enables client admins to enable and disable User Assistance for End Users for their SAP Concur Users. User Assistance for End Users can be enabled and disabled based on a user's designated country of residence.
Concur Expense is required to access User Assistance for End Users.
On entities running SAP Concur Professional edition, User Assistance for End Users is enabled based on the Country of Residence assigned to a user in the Expense Settings section of their user account.

On entities running SAP Concur Standard edition, User Assistance for End Users is enabled based on the Country/Region of Residence assigned to a user in the User Information section of their user account.
The four added countries/regions are enabled by default. Client admins who do not want the countries/regions to be enabled must disable them.
To disable countries/regions on the User Assistance page:
1. Navigate to the User Assistance page.
Professional Edition:
Click Administration > Company > Company Admin.
Standard Edition:
Click Administration > Company > Tools.
Scroll through the list to the countries/regions you want to disable.
[image: ]
Uncheck (disable) the box next to the desired country/region, and then click Save.
[image: ]
Configuration / Feature Activation
The four countries/regions are added automatically. By default, the added countries/regions are enabled. Client admins who do not want these countries/regions enabled must disable them on the User Assistance page.
[bookmark: _Toc96077920]Web Services Administration
[bookmark: _Toc31271709][bookmark: _Toc96077921]**Ongoing** Application Connector Username and Password Length Requirements Updated

	Information First Published
	Information Last Modified
	Feature Target Release Date

	January 14, 2022
	January 14, 2022
	February 28, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96077922]Expense, Request, Web Services | Professional & Standard
These changes are part of the SAP Concur continued commitment to maintaining secure authentication.
Overview
To meet new security requirements, the length of the username and password associated with an application connector on the Application Connectors page must be at least 10 characters long and not more than 50 characters long. 
Some clients currently have usernames and passwords configured that do not meet these parameters. 
On February 28, 2022, the 10-character minimum and 50-character maximum will be enforced. If the usernames and passwords are not updated prior to this change, some aspects of SAP Concur solutions might stop working. For example, workflow steps will not complete if using notifications, LEU windows will not open, and there will be no results in fields using fetch lists.
To avoid disruption of callouts through application connections and subsequent disruption of some end-user tasks, SAP recommends updating your application connector username(s) and password(s) as soon as possible.
Application connection usernames and passwords can be updated by an administrator with the Company Administrator or Web Services Administrator role.
For admins working with Standard entities, a user with the Concur Expense Can Administer permission has the Web Services Administrator role.
Business Purpose / Client Benefit
Enforcing password and username length restrictions improves the security standards for callouts made through the application connector.
Configuration / Feature Activation
Usernames and passwords for application connectors are configured on the Manage Application Connectors page. 
To change the username and password for an application connector:
1. Click Administration > Company > Web Services.
[image: ]
Click Manage Application Connectors.
[image: ]
Choose the application connector you want to update and then click Modify.
[image: ]
Enter the new username and password and then click Test Connection.
[image: ]
Click Save.
After you update the username and password for an application connector, you must click Test Connection to verify the changes before the application connector can be used for any of the callout services. 
For more information, refer to Callouts and Application Connectors on the SAP Concur Developer Center.
[bookmark: _Toc96077923]Planned Changes
[bookmark: _Hlk92890624]The following features and changes are targeted for future releases. SAP Concur solutions reserves the right to postpone implementation of – or completely remove – any enhancement/change mentioned here. 
[bookmark: _Toc46229145][bookmark: _Hlk523311325][bookmark: _Toc478727899][bookmark: _Toc96077924]Fax Feature
[bookmark: _Toc96077925]**Planned Changes** Fax Feature to be Decommissioned

	Information First Published
	Information Last Modified
	Feature Target Release Date

	November 2021
	January 14, 2022
	October 1, 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96077926]Expense, Invoice | Professional & Standard
Overview
On October 1, 2022 the Concur Fax Feature will be decommissioned.
[bookmark: _Hlk86919337]The Fax feature was retired in 2020. Clients onboarded after July 15, 2020 do not have access to this feature. Among clients with access, very few use the feature regularly and, among those that use it, use has declined steadily.
Business Purpose / Client Benefit
Removal of the Fax feature improves the security, performance, and scalability of SAP Concur solutions. 
In addition, The Concur Fax Feature attaches files only at the header level of expenses and invoices. As a result, clients who use the Fax Feature cannot take advantage of recent innovations that apply only to images and attachments at the line-item level.
What the User Sees
Users will no longer have the option to print Fax cover pages from within Concur Expense or Concur Invoice and they will no longer have the ability to fax images to SAP Concur for attachment to expenses or invoices.
Configuration / Feature Activation
This change occurs automatically; there are no configuration steps. 
Additional information about this change will be made available over the coming months.
[bookmark: _Toc79737887]
[bookmark: _Toc96077927]Help Menu
[bookmark: _Toc96077928]**Planned Changes** Consolidation of Resources Under Help Menu

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 18, 2022
	--
	May 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96077929]All Products | All Editions
Overview
In May, SAP plans to update the Help menu in SAP Concur Solutions to consolidate access to help resources in a single location. 
Business Purpose / Client Benefit
This change will improve ease of use and simplify the SAP Concur user interface by providing a single point of access to help resources.
What the User Sees
The user will see new options in the Help menu, for example, if User Assistance for End Users is enabled, the user will see a link to access User Assistance for End User content in the Help menu.
Configuration / Feature Activation
This change occurs automatically.
[bookmark: _Toc96077930]Product Settings
[bookmark: _Toc96077931]**Planned Changes** Advanced and Basic Views Added to Product Settings

	Information First Published
	Information Last Modified
	Feature Target Release Date

	January 21, 2022
	--
	February 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96077932]Expense, Invoice, Request | Standard
Overview
SAP Concur plans to add the ability to switch between basic and advanced views in Product Settings.
Prior to this change, changing the view between basic and advanced settings in Product Settings required the assistance of an SAP Concur internal administrator.
Business Purpose / Client Benefit
This change enables client admins to view or hide their advanced settings as needed without assistance from SAP Concur personnel. 
What the Admin Sees
By default, only the basic tiles appear on the Product Settings page. When an admin navigates to Product Settings, they see the basic tiles and they see the View Advanced Settings link under the Product menu in Product Settings.
[image: ]
When the admin clicks View Advanced Settings, the advanced tiles appear on the Product Settings page, and the link under the Product menu changes to View Basic Settings.
The settings tiles that appear in advanced view vary depending on your configuration. 
When an admin switches to advanced view, the view persists only for the current session. If the admin signs out of their SAP Concur product, when they sign back in, the view will be reset to the basic (default) view.
Configuration / Feature Activation
This change occurs automatically; there are no configuration or activation steps.
[bookmark: _Toc96077933]Profile Settings
[bookmark: _Toc96077934]**Planned Changes** Changes to My Profile, Home Page, and Profile Menu

	Information First Published
	Information Last Modified
	Feature Target Release Date

	January 21, 2022
	February 18, 2022
	Ongoing beginning in 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96077935]Travel, Expense, Invoice, Request, Mobile | Professional & Standard
Overview
SAP Concur plans to implement changes to several pages in the UI. The changes will be implemented over time beginning in Q2 of 2022. 
These changes reflect SAP's commitment to supporting gender diversity by enabling gender non-binary users to enter consistent information when making travel arrangements and entering information in SAP Concur solutions. Changes include but are not limited to the following:
· The greeting on the SAP Concur Home page will be removed.
· The Nickname field on the My Profile – Personal Information page will be changed from Nickname to Preferred Name.
· A new option, Mx, will be added to the Title list on the My Profile – Personal Information page.
· If a user adds their preferred name on the My Profile – Personal Information page in Profile Settings, their preferred name and last name will be displayed in the SAP Concur Profile menu and in the menu in the Mobile app.
· New options will be added to enable users to select a non-binary gender in the TSA Secure Flight section of Travel Preferences.
· The Nickname field in the Employee Travel Addendum Import 350 file will be changed from Nick Name to Preferred Name.
· The Nickname field in the Employee Import file will be changed from Nickname to Preferred Name.
Business Purpose / Client Benefit
These changes:
· Enable users to enter information into SAP Concur solutions that is consistent with their identity.
· Enable SAP Concur solutions to address a user by their preferred name.
· Ensure that information in SAP Concur solutions matches a user's government-issued identification.
· Ensure that travel documents such as airplane tickets purchased through SAP Concur solutions display information that is consistent with other required documents.
What the User Sees
SAP Concur plans to implement these changes overtime beginning in Q2 of 2022. When they are implemented, users will see the following changes.
Web UI Page Header
After signing in to SAP Concur, users currently see a greeting on the Concur home page, "Hello <first name>". The greeting includes the name from the First Name field in their user account.
[image: ]
After these changes are implemented, users will no longer see this greeting.
Current View My Profile - Personal Information
Currently, users see the Nickname field and a list of name prefixes in the Title field.
[image: ]
When these changes are implemented, users will see the Preferred Name field instead of the Nickname field.
In addition, a new gender non-binary option, Mx (pronounced "Mix"), will be added to the list in the Title field.
Current View Travel Preferences TSA Secure Flight
Currently, users see two options under Gender in the TSA Secure Flight section of Travel Preferences. 
[image: ]
After the changes are implemented, users will have two additional options under Gender: undisclosed (x) and unspecified (u). 
Current View Web UI Profile Menu
Today, when a user clicks on Profile, they see the first and last names from the respective fields in their user account.
[image: ]
After these changes are implemented, if the user has specified a preferred name on the Profile – Personal Information page in Profile Settings, when they click on Profile in the web version of SAP Concur solutions, their preferred name and last name will be displayed. 
If the user has not specified a preferred name, their first and last names from their user account information will be displayed.
In addition, when users with permission to act on behalf of another user—for example, Travel Arrangers and Delegates—search for and act as another user, they will see the preferred name of the user they are acting on behalf of in the search field and at the top of the Profile menu.
[image: ]   [image: ] 
Current View – Mobile App
The menu in the Mobile app currently displays the first and last names from the respective fields in the user's user account.
[image: ]
After these changes are implemented, no name will be displayed at the top of the Mobile app menu.
What the Admin Sees
Admins will see changes to the Nickname fields in import and extract files.
Employee Travel Addendum Import 350
Administrators currently see Nick Name in field 5.
[image: ]
When these changes are implemented, they will see Preferred Name in field 5.
User Import
Currently, administrator see Nickname.
[image: ]
 When these changes are implemented, they will see Preferred Name.
Configuration / Feature Activation
These changes will occur automatically. Users might need to update the information on the My Profile – Personal Information page after the new options are added. 
More information about these changes will be included in future release notes.
[bookmark: _Toc96077936]SAP Concur Support
[bookmark: _Toc96077937]**Planned Changes** Suggested Solutions Migration

	Information First Published
	Information Last Modified
	Feature Target Release Date

	November 5, 2021
	January 14, 2022
	Q1 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96077938]All Products & Services | Professional & Standard
Overview
Targeted for Q1 2022, the Solution Suggestions platform that SAP Concur provides will be migrated into the SAP Continuous Influence – Improvement Requests program. 
This change will provide a better user experience and a single place for Authorized Support Contact (ASC) users to engage with all SAP Concur Customer Influence programs. 
Tool usage for ConcurGov and Concur Cloud for Public Sector clients is still being evaluated. Additional information for these impacted client groups will be shared in the near future.
For more information, refer to SAP Continuous Influence Sessions.
Business Purpose / Client Benefit
In addition to offering a better tool with more functionality, SAP Concur is enhancing the process of how improvement requests will be reviewed, considered, and prioritized. 
What the User Sees
Beginning with the November release, Authorized Support Contact users saw an updated Suggestions section on the Contact Support page. 
Depending on the user’s Support access level, the Suggestions section may or may not appear.
Before Update
[image: ]
After Update
[image: ]
Configuration / Feature Activation
The change will occur automatically; there are no additional configuration or activation steps.
[bookmark: _Toc96077939]SSO Management
[bookmark: _Toc96077940]**Planned Changes** Checkbox to Hide SSO Sign-In Option

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 11, 2022
	--
	Q2 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96077941]Travel, Expense, Invoice, Request | Professional & Standard
Overview
In a future release, SAP Concur plans to add a checkbox to the Add IdP Metadata dialog. The checkbox will enable the SSO administrator to prevent the specified SSO sign-in method from appearing to users as a sign-in option on the concursolutions.com sign-in page.
User will still be able to sign-in via the method through other navigation paths as outlined by their company. 
Business Purpose / Client Benefit
The addition of this checkbox gives the SSO administrator greater control over how end-users sign in to SAP Concur solutions.
What the SSO Admin Sees
When the admin navigates to the Manage Single Sign-On page and then clicks Add in the IdP Metadata section, they will see the new checkbox at the bottom of the Add IdP Metadata dialog.
Configuration / Feature Activation
The checkbox will be added to the Add IdP Metadata page automatically.
More information about this change will be included in future release notes.
[bookmark: _Toc96077942]**Planned Changes** Option to Provide URL to IdP Metadata to be Removed

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 11, 2022
	February 18, 2022
	Q2 2022

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96077943]Travel, Expense, Invoice, Request | Professional & Standard
Overview
In a future release, SAP Concur plans to remove the Provide link to your IdP's metadata field from the Add IdP Metadata dialog.
Business Purpose / Client Benefit
In order to use the Provide link to your IdP's metadata field, clients must first open a support ticket to have the URL added to SAP Concur's allow list. These additional steps do not support the goal of making the SSO management process self-service for our clients.
What the SSO Admin Sees
When the admin navigates to the Manage Single Sign-On page and then clicks Add in the IdP Metadata section, they will no longer see the Provide link to your IdP's metadata field in the Add IdP Metadata dialog.
The admin will still have the ability to upload IdP metadata by clicking Upload XML File.
Configuration / Feature Activation
The field will be removed from the Add IdP Metadata page automatically.
More information about this change will be included in future release notes.
[bookmark: _Toc96077944]User Assistance
[bookmark: _Toc96077945]**Planned Changes** Support for SAP Enable Now

	Information First Published
	Information Last Modified
	Feature Target Release Date

	February 11, 2022
	--
	Future Release

	Any changes since the previous monthly release are highlighted in yellow in this release note.


Applies to:
[bookmark: _Toc96077946]Travel, Expense, Invoice, Request | Professional & Standard
Overview
In a future release, SAP plans to add support for SAP Enable Now with SAP Concur solutions. 
Business Purpose / Client Benefit
This change will enable clients to use SAP Enable Now to create user assistance content to improve user adoption and increase efficiency with SAP Concur solutions.
Configuration / Feature Activation
After support for SAP Enable Now has been added to SAP Concur solutions, clients who have User Assistance enabled for their SAP Concur solutions will be able to enable and disable SAP Enable Now on the SAP Concur User Assistance page.
More detailed information about this feature will be included in a future release note.
[bookmark: _Toc510082427][bookmark: _Toc12880017][bookmark: _Toc46229154][bookmark: _Toc11147478][bookmark: _Toc96077947]Client Notifications
[bookmark: _Toc69211924][bookmark: _Toc480899347][bookmark: _Toc483562026][bookmark: _Toc484092107][bookmark: _Toc480899345][bookmark: _Toc483562024][bookmark: _Toc484092109][bookmark: _Toc510082430][bookmark: _Toc514338227][bookmark: _Toc12880020][bookmark: _Toc46229157][bookmark: _Toc96077948]Accessibility
[bookmark: _Toc69211925][bookmark: _Toc96077949]Accessibility Enhancements
SAP implements changes to better meet current Web Content Accessibility Guidelines (WCAG). Information about accessibility-related changes made to SAP Concur solutions is published on a quarterly basis. You can review the quarterly updates on the Accessibility Updates (English Only) page.
[bookmark: _Toc96077950]Subprocessors
[bookmark: _Toc96077951]SAP Concur Non-Affiliated Subprocessors
The list of non-affiliated subprocessors is available here: SAP Concur list of Subprocessors
If you have questions or comments, please reach out to: Privacy-Request@Concur.com
[bookmark: _Toc77840903][bookmark: _Toc96077952]Supported Browsers
[bookmark: _Toc77840904][bookmark: _Toc96077953]Supported Browsers and Changes to Support
For information about supported browsers and planned changes to supported browsers, refer to the Concur Travel & Expense Supported Configurations guide.
When changes to browser support are planned, information about those changes will also appear in the Shared Planned Changes release notes.
[bookmark: _Toc90037239][bookmark: _Toc96077954]Additional Release Notes and Other Technical Documentation
[bookmark: _Toc90037240][bookmark: _Toc96077955]Online Help
Any user can access release notes, setup guides, user guides, admin summaries, monthly browser certifications, supported configurations, and other resources via online Help or directly on the SAP Help Portal.
Use the links in the Help menu in the app, or search for your SAP Concur product (Concur Expense, Concur Invoice, Concur Request, or Concur Travel) on the SAP Help Portal (https://help.sap.com) to view the full set of documentation for your product.
[bookmark: _Toc90037241][bookmark: _Toc96077956][bookmark: _Toc530557893]SAP Concur Support Portal – Selected Users
Access release notes, webinars, and other technical documentation on the SAP Concur support portal.
If you have the proper permissions, Contact Support appears on the Help menu. Click to access the SAP Concur support portal, then click Resources. 
Click Release/Tech Info for release notes, technical documents, etc. 
Click Webinars for recorded and live webinars.
[image: P1891#yIS1]
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# Additionally, comments (such as these) may be inserted on individual
#lines or following the machine name denoted by a # symbol.

#

# For example:

#

# 102549497  rhino.acme.com # source server

# 38256310 xacme.com #x client host

# localhost name resolution is handled within DNS itself.
# 127001 localhost
# A localhost

104.76.225 252 www concursolutions.com
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Travel Addendum Import (Record Type 350) Format

The 350-level record is used with either the 305-level (Expense & Travel user) or the 310-level (Travel only user) record block, or the user must already exist in the Expense database / system.

! The 350 record import functionality is not available if the Email login option is used.

Table 6: Data for record ID "TravelAddendumImport”

1 Transaction Type 350 Y. This is a static numeric value always equal to 350. It indicates the Record Type

2 Employee ID 48 characters maximum Y. Must match a 305-level record in this file

3 Name Prefix 60 characters maximum N Must contain these exact values (Lord, Lady, Sir, Mr, Miss, Ms, Mrs, Dr, Rev, Prof)
4 Name Suffix 60 characters maximum N Must contain these exact values (Jr., Sr., I, II, III, IV, V, VI)

5 Nick Name 60 characters maximum N Informal, non-birth name employee is known as.
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Prefix Name N If provided, must contain one of these exact values (Lord, Lady, Sir, Mr., Miss, Ms., Mrs., Dr., Rev.)
Suffix Name N If provided, must contain one of these exact values (Jr,, Sr., I, II, III, 1V, V)

Informal, non-birth name employee is known as.
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UGGESTION:

What would improve your travel booking, expense reporting process? Share with us your ideas for
Invoice and Mobile! We know you've got suggestions for Concur and we want to hear them!
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**Planned Changes™*

Coming Q12022 Concur Solution Suggestions is evalving to the SAP Continuous Influence -
Improvement Requests platform. This change offers not only a better experience, but a single
place for youto engage with all of our Customer Influence programs

Tolearmmore, please visit our Continuous Influence information page.

Suggestions submitted after December 1, 2021 will not be reviewed i order to support this
change. If you have a great idea you'd like to share, make sure to come back here in QL to
submit your Improvement Request!





